
PRACTICE EXAM 567

OPERATING SYSTEM

TECHNOLOGIES

This exam simulates the CompTIA A+ Operating
System Technologies exam. It is representative of what
you should expect on the actual exam. The answers and
the explanations for the answers follow the questions. It
is strongly suggested that when you take this exam, you
treat it just as you would the actual exam. Time your-
self, read carefully, and answer all the questions as best
you can. There are 80 questions, just as there are on the
actual exam. Set a 90-minute time limit for yourself.
This is the amount of time you are given to take the real
thing. The questions reflect the amount of coverage
given to each domain in the exam:

Domain Percentage Number
of Exam of Questions

1.0 Operating System 28% 22
Fundamentals

2.0 Installation, 
Configuration, and 31% 25
Upgrading

3.0 Diagnosing and 25% 20
Troubleshooting

4.0 Networks 16% 13

You should take the exam and score it. If you score
lower than 75%, you should try rereading the chapters
on the domains with which you had trouble.

Practice Exam
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5. Which of the following file types cannot be run
from the DOS prompt?

A. .BAT

B. .EXE

C. .RUN

D. .COM

6. __________ interprets input from the command
prompt.

A. IO.SYS

B. MSDOS.SYS

C. COMMAND.COM

D. BIO.COM

7. In Windows 2000, which utility would you use to
rewrite scattered parts of files into contiguous
sectors on a hard disk?

A. The Add/Remove Hardware applet

B. The Disk Defrag utility

C. The Disk Cleanup utility

D. The Backup utility

8. The MYFILE.EXE file is located in the C:\Test
directory. To execute the file from anywhere, you
__________.

A. add C:\Test to the Path statement.

B. add the line C:\Test\MYFILE.EXE to the 
CONFIG.SYS file.

C. add the line DEVICE=MYFILE.EXE to the AUTOEX-
EC.BAT file.

D. add ;C:\TEST to the Path statement.

EXAM QUESTIONS

1. In Windows XP ______ is the practice through
which drivers are preapproved by Microsoft so that
they can be loaded automatically by the system.

A. DLL signing

B. file signing

C. WHQL signing

D. Driver signing

2. The purpose of a device driver is to __________.

A. tell the operating system device how to inter-
face with an external device

B. provide more useful memory by moving
device control data to extended memory

C. improve performance of installed devices by
optimizing access patterns

D. modify application programs to work correct-
ly with devices attached to the system

3. Which of the following tools is used to back up
the system in Windows XP?

A. Emergency Repair Backup

B. Recovery Console Backup

C. ASR Backup

D. ERD Backup

4. Memory-manager programs are loaded from
_________.

A. the AUTOEXEC.BAT file

B. BIOS

C. the CONFIG.SYS file

D. CMOS
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9. To configure the file MYFILE.TXT as read-only, you
use the _____ DOS command.

A. ATTRIB +A MYFILE.TXT

B. ATTRIB –A MYFILE.TXT

C. ATTRIB +R MYFILE.TXT

D. ATTRIB–R MYFILE.TXT

10. What is the primary GUI for Windows operating
systems?

A. the monitor

B. the desktop GUI

C. the command prompt

D. the keyboard

11. You are installing new hardware in a Windows
2000 system that does not use PnP. From where
can you install the drivers for the new devices?

A. the Add/Remove Hardware Wizard

B. the System Properties icon

C. the Device Manager utility

D. the Add New Programs Wizard

12. In Windows 9x, a filename can be up to _____
characters long.

A. 8

B. 16

C. 32

D. 255

13. When Windows 95 boots up successfully, the
Registry files are backed up and given the _____
extension.

A. .DAT

B. .DOC

C. .DA0

D. .DMM

14. The ScanDisk utility runs automatically in a
Windows 9x or 2000 system _____.

A. each time the system is shut down

B. once a week

C. according to the schedule established in the
Computer Management Console

D. whenever Windows is shut down incorrectly

15. In Windows 9x the command used to edit the
Registry is _____.

A. SysEdit

B. RegEdit

C. AutoEdit

D. WinEdit

16. Where can a startup disk be created in the
Windows 9x environment?

A. In the Add/Remove Programs Wizard

B. In the \System Tools directory

C. In Windows Explorer

D. In the Start menu’s Run dialog box

17. If an application hangs up in Windows 2000, you
should _____.

A. press Alt+Tab, click Applications, and close
applications that are not responding

B. press Ctrl+Alt+Del, click Task Manager, click
Applications, and close applications that are
not responding

C. press Ctrl+Esc, click Applications, and select
the appropriate application to close

D. turn off the power to the system unit and
restart
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C. the Windows 2000 virtual memory swap file

D. the Windows 2000 expanded memory 
manager

23. Which file is responsible for loading Windows
2000?

A. BOOT.INI

B. KERNEL32.EXE

C. WIN.COM

D. NTLDR

24. Windows 2000 is based on which file-
management system?

A. NTFS3

B. NTFS4

C. NTFS5

D. HPFS

25. How do upper memory and high memory differ?

A. There is no difference.

B. Upper memory is any memory above 1MB.

C. High memory is the memory between 640KB
and 1MB.

D. High memory is the first 64KB area of memo-
ry above 1MB.

26. The Windows 9x System Monitor can be used to
_____.

A. view monochromatic graphics in color

B. input TV signals directly

C. reproduce U.S. currency

D. detect major system bottlenecks

27. What is the purpose of HIMEM.SYS?

A. It controls the shadow RAM operations.

18. A customer cannot find the file QUESTIONPOOL.DOC
while searching in MS-DOS mode. The customer
should _____.

A. look for an abbreviated name for the file, such
as QUESTI~1.DOC

B. assume that the file has been deleted

C. look for the file in Windows 95 instead

D. look for an abbreviated name for the file, such
as QUESTION.DOC

19. ScanDisk does all the following except _____.

A. relocate data into sequential sectors

B. check the FAT

C. review the filenames

D. locate cross-referenced sectors

20. Which Windows 2000 command starts a new
instance of the Windows 2000 command-prompt
interpreter?

A. Run

B. Execute

C. Start

D. CMD

21. In Windows 95, which command-line utility can
be used to convert FAT16 partitions into FAT32
partitions?

A. CONVERT

B. CNVT1632

C. CVT.EXE

D. PARTCHNG

22. PAGEFILE.SYS is ______.

A. the Windows 98 virtual memory swap file

B. the Windows 98 expanded memory manager

19PEv2  4/13/04  12:53 PM  Page 570



PRACTICE EXAM 571

B. It loads programs into expanded memory.

C. It loads the ROM BIOS into the high memory
area.

D. It loads programs into extended memory.

28. Memory from 0KB to 640KB is called _____
memory.

A. enhanced

B. conventional

C. expanded

D. extended

29. What are the minimum hardware requirements for
installing Windows 2000 Professional?

A. 133MHz Pentium processor with 64MB RAM
installed

B. 150MHz Pentium processor with 32MB RAM
installed

C. 166MHz Pentium processor with 24MB RAM
installed

D. 266MHz Pentium processor with 32MB RAM
installed

30. To install Windows 9x on the system’s D: drive,
you __________.

A. disconnect the C: drive from the system
before installing Windows

B. copy the Windows directory to the D: drive
after Windows has been installed

C. click the Other Directory option during the
setup routine and change the install path

D. use the Move function in Windows Explorer
to move the Windows directory to the D: drive
after Windows has been installed

31. To install a network printer from Windows 9x,
you _____.

A. select File, Print from the application, and
then click the Printer button and select the
printer

B. select Start, Settings, Printers, and then select
the printer to install

C. click the My Computer icon, click the Printers
folder, and select the printer

D. click the Network Neighborhood icon, com-
puter name, printer name, and then right-click
Install

32. Which startup mode is not a Window 9x mode?

A. Normal mode

B. Safe mode

C. Standard mode

D. MS-DOS mode

33. Identify the correct sequence of events that occur
when Windows 2000 is started?

A. NTLDR, NTDETECT.COM, BOOT.INI

B. BOOT.INI, NTDETECT.COM, NTLDR

C. NTDETECT.COM, NTLDR, BOOT.INI

D. NTLDR, BOOT.INI, NTDETECT.COM

34. The purpose of Safe mode in Windows is to
_______.

A. start Windows with minimal drivers loaded

B. single-step through the Windows startup
process

C. skip all the Windows configuration steps

D. start Windows with an MS-DOS command
line
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39. To boot directly into Safe mode, you press
_______ while the Starting Windows 9x message
is onscreen.

A. F3

B. F4

C. F5

D. F8

40. If PnP is not working in Windows 2000, from
where can you install a device driver?

A. the Start menu

B. the My Computer window

C. the Add/Remove Programs Wizard

D. the Add New Hardware Wizard

41. Which is not an acceptable way to install a device
driver in Windows 9x?

A. Let the PnP function install it.

B. Use the Device Manager to install it.

C. Use the Add New Hardware Wizard to 
install it.

D. Use the Add/Remove Programs Wizard to
install it.

42. You suspect that a program is causing errors in a
Windows 2000 system, but the system is not
reporting any errors. What tool would you use to
view errors in the system?

A. Event Viewer

B. Local Security Policy

C. Services

D. Component Services

35. What partition must be on the hard-disk drive to
install Windows 95?

A. CDFS

B. NTFS

C. FAT

D. HPFS

36. The boot sequence for Windows 9x is _____.

A. POST, Bootstrap Loader, IO.SYS, MSDOS.SYS,
COMMAND.COM, CONFIG.SYS

B. POST, Bootstrap Loader, IO.SYS, CONFIG.SYS,
COMMAND.COM, MSDOS.SYS, AUTOEXEC.BAT

C. POST, Bootstrap Loader, IO.SYS, CONFIG.SYS,
MSDOS.SYS, COMMAND.COM, AUTOEXEC.BAT

D. POST, Bootstrap Loader, IO.SYS, CONFIG.SYS,
MSDOS.SYS, AUTOEXEC.BAT, COMMAND.COM

37. Which Windows 2000 administrative tool can you
use to view several administrative tools, such as
Event Viewer and Device Manager, in one win-
dow?

A. Tool Viewer

B. Services and Applications

C. Computer Management Console

D. Performance Meter

38. To single-step through the Windows 9x boot
process, you press _______________ while the
Starting Windows message is onscreen.

A. F3

B. F4

C. F5

D. F8

19PEv2  4/13/04  12:53 PM  Page 572



PRACTICE EXAM 573

43. The main reason to encrypt a file is to ________.

A. reduce its size

B. protect it from unauthorized access

C. prepare it for backup

D. include it in the startup sequence

44. Which of the following is not true regarding the
boot sector?

A. It contains the MBR.

B. It contains the disk’s partition table.

C. It resides on each disk partition.

D. It contains information about the drive and
disk.

45. You can enter Boot logging mode by pressing ___
during the Windows 2000 or XP startup.

A. F1

B. Ctrl

C. F8

D. Esc+F4

46. Which of the following protocols was designed to
be used with a Novell network?

A. TCP/IP

B. IrLAN

C. IPX/SPX

D. NetBEUI

47. VxDs for Windows 9x are designed for _____
operation.

A. 8-bit

B. 16-bit

C. 32-bit

D. 64-bit

48. What type of networking is included as the
default in Windows 9x?

A. None

B. Peer-to-peer

C. Client-based

D. Workstation

49. A customer has asked you to install a 5GB hard
drive in his Windows 95b machine. He wants to
use the entire drive but does not want to change
his operating system. What’s the minimum num-
ber of partitions you must have to be able to uti-
lize the whole drive?

A. 1

B. 2

C. 3

D. 4

50. Which protocol enables a network server to assign
an IP address to a network node?

A. RAS

B. DNS

C. DHCP

D. WINS

51. Which of the following presents the least likely
cause of computer virus infections?

A. Shareware programs

B. Bulletin board software

C. User-copied software

D. Shrink-wrapped original software
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B. standard operation checks the disk surface on
the drive that you specify

C. thorough operation checks the disk surface,
files, and folders on the drive that you specify

D. standard operation checks the disk surface,
files, and folders on the drive that you specify

57. To share a printer in Windows 9x, you _____.

A. double-click its icon, select Printer, Properties,
Sharing, and choose the configuration

B. right-click its icon, select Sharing, and choose
the configuration

C. right-click its icon, select Properties, Sharing,
and choose the configuration

D. perform any of the first three choices, A–C

58. If a printer attached to a Windows computer is not
producing any output, even though pages are
being sent to the printer, what should you do?

A. Check the printer driver.

B. Check the print spooler.

C. Check the printer pool.

D. Check file and print sharing.

59. Device Manager can do all the following except
_____.

A. update drivers

B. change peripheral I/O settings

C. check for viruses

D. identify installed ports

60. The Device Manager displays a red X symbol
when _____.

A. a device is disabled due to some type of user-
selection conflict

52. To replace a missing or corrupt Windows 9x file
from the Windows 9x CD-ROM, you use _____.

A. SUBTRACT.EXE

B. COMPACT.EXE

C. EXTRACT.EXE

D. LOCATE.EXE

53. A system is running in Windows 9x and then
stops. Restarting the system is unsuccessful. What
is the problem?

A. The power supply is bad.

B. The virtual memory function is enabled.

C. The virtual memory function is disabled.

D. The hard-drive controller is defective.

54. If an application freezes in Windows 9x, you can
press _____ to remove the offending task.

A. Alt+Tab

B. Ctrl+Alt+Del

C. Esc

D. Alt+Esc

55. What TCP/IP utility is commonly used to test a
remote network node to see whether it is active?

A. IPCONFIG

B. ARP

C. PING

D. WinIPCFG

56. When you are comparing thorough ScanDisk
operation with standard ScanDisk operation,
_____.

A. thorough operation checks the files and fold-
ers on the drive that you specify
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B. a device is experiencing a direct hardware
conflict with another device

C. the selected device is not present on the system

D. the selected device is not operating properly
and requires repair

61. In Windows 9x, where do you go to correct any
conflicting IRQs?

A. Print Manager

B. Device Manager

C. File Manager

D. System Manager

62. Which of the following is the correct UNC net-
work pathname format?

A. \\server_name\computer_name\user_name

B. \\computer_name\share_name

C. \\user_name\computer_name\share_name

D. \\computer_name\user_name\share_name

63. How can you see hidden files in Windows 2000?

A. Edit the appropriate Registry entry.

B. Right-click My Computer, select Properties,
click the View tab, and change to the appro-
priate setting.

C. Run Explorer, click the Tools menu, select
Folder Options, click the View tab, and
change to the appropriate setting.

D. Right-click the desktop, click Properties, click
the View tab, and change to the appropriate
setting.

64. ISPs _____.

A. install modems

B. provide Internet addresses

C. install cable

D. create Internet browsers

65. A customer wants to use an installed modem for
Internet operation. You should _____.

A. install another modem and get the ISP infor-
mation

B. get the ISP information

C. install dial-up networking and enter the ISP
information

D. install dial-up networking

66. In Windows 2000 Professional, where are TCP/IP
utility programs run?

A. at the MS-DOS command prompt

B. at the TCP/IP Properties window

C. at the window that appears when you double-
click the file TCPIP.COM

D. at the Run window, which is accessed via the
Start menu

67. What condition causes other network users to not
be able to see any files on your local machine?

A. You have not enabled the File and Print
Sharing option on the local computer.

B. The remote computers have not enabled the
File and Print Sharing option for your comput-
er.

C. The local computer is password protected, and
the users have not entered the correct pass-
word to gain access.

D. The remote computers do not have their direc-
tories shared.

68. What file type is not associated with the Internet?

A. HTML

B. FTP
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73. Which subfolder in Windows XP contains the
configuration information about every user who
has logged on?

A. \Winnt\Profiles

B. \WinXP\Profiles

C. \Winsys\DAT

D. \Xpuser.Dat

74. What Windows XP function qualifies threads of
any process to be addressed to any available
processor in the system?

A. PMA

B. PMS

C. AMP

D. SMP

75. What type of installation process do administra-
tors run to perform multiple Windows XP installa-
tions across a network at one time?

A. disk cloning

B. attended

C. unattended

D. client

76. Microsoft releases its operating system updates in
collections that include additional features or new
drivers. These collections are referred to as
__________.

A. bug fixes

B. service patches

C. service packs

D. update services

C. X.40

D. POP3

69. What could cause a properly mapped drive to dis-
appear when the system is rebooted?

A. The installed network protocol has been cor-
rupted.

B. The network interface card is bad.

C. The Reconnect at Logon option has not been
selected.

D. Mapped drives must always be reentered
when the system is rebooted.

70. Which TCP/IP utility traces the connection path
from your terminal to a remote Internet address?

A. NBTSTAT

B. NETVIEW

C. TRACERT

D. PING

71. What is the Windows XP bootstrap loader file-
name that is equivalent to the Windows 9x IO.SYS
file?

A. XPLDR

B. NTLDR

C. IO.LDR

D. LDR.SYS

72. Which user configuration file in Windows XP is
stored in  \Documents_and_Settings\username?

A. user.profiles\Winnt

B. Xpuser.dat

C. Ntuser.pro

D. Ntuser.dat
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77. What is the minimum hard-drive space required
for installing Windows XP?

A. 2MB

B. 650GB

C. 2GB

D. 650MB

78. The Windows XP ______ is a command-line
interface that provides access to the hard disks
and utilities when the operating system will not
operate.

A. Registry mode

B. Recovery Console

C. Recovery mode

D. Repair Console

79. Which of the following is the primary use of the
Recovery Console in Windows XP?

A. installing hardware

B. copying hard-drive files to floppy disk

C. repairing the Registry

D. recovering Web pages

80. Which Windows XP utility enables administrators
to roll back the operating system to a previous
operational state in which the system was func-
tioning properly?

A. Recovery Console

B. System Restore

C. Safe Mode

D. System Reset

ANSWERS TO EXAM QUESTIONS

1. D. Microsoft works with hardware vendors to cer-
tify their drivers. These drivers are digitally
signed so that they can be loaded automatically by
the system.

2. A. The device driver is a piece of interfacing soft-
ware that tells the operating system how to com-
municate with and manage an external device.
Applications use the driver, through the operating
system, to address devices, but the driver does not
alter the application.

3. C. The ASR tool can be used to back up and
restore the system state information, along with
all the files stored on the system volume.

4. C. The CONFIG.SYS file’s statements are responsi-
ble for loading the system’s memory managers.
This normally involves the HIMEM.SYS and EMM386
lines.

5. C. There is no system extension .RUN. All the
other file types can be executed directly from the
DOS command line.

6. C. The COMMAND.COM command interpreter is
responsible for accepting input from the DOS
command line and interpreting it for the system.

7. B. The Defrag utility rearranges files and unused
space on the hard disk into contiguous blocks so
that the drive can operate more efficiently.

8. D. The Path statement in the AUTOEXEC.BAT file
sets up the system with an automatic search order
for executing files. To make a file, such as
MYFILE.EXE, able to be executed from anywhere,
you must add the filename to the Path statement
(with a semicolon at the beginning).
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not responding. You can use Task Manager to
view applications, processes, and system perfor-
mance, and to shut down anything that is not
responding.

18. A. If the file was saved with a Windows 9x long
filename, a directory listing does not display the
name in its entirety. Instead, the name is truncated
(shortened) and displayed with a tilde character
(~) in the seventh position of the filename. A
numeric character, beginning with 1, is inserted
into the eighth character position, to show that it
is the first iteration of the truncated filename (for
example, QUESTI~1.DOC). If other filenames are
created with the same first six characters, they are
labeled as the second, third, and so on iterations.

19. A. The ScanDisk utility does not relocate blocks
of data into sequential sectors. This is the function
of the Disk Defrag utility.

20. D. The CMD command is used to start the Windows
2000 command interpreter. It can be used to set
the environment variables of the new interpreter.

21. C. In Windows 9x, it is possible to convert parti-
tions created on a FAT16 drive into a FAT32 file
system by using the CVT.EXE command-line utility.
This operation can also be performed by access-
ing the Drive Converter (FAT32) utility; to do so,
select Start, Programs, Accessories, System Tools,
Drive Converter.

22. C. PAGEFILE.SYS is a swap filename used in
Windows NT or 2000. When a computer is run-
ning low on memory, Windows NT or 2000 can
use hard-drive space, PAGEFILE.SYS, to simulate
RAM.

23. D. The NTLDR file, along with NTDETECT, loads the
Windows NT/2000 operating system into memory.

24. C. The newest NTFS file system (NTFS5) is
included in Windows 2000. It has some 

9. C. The +R switch modifies the ATTRIB command to
mark the specified file as read-only. The –R switch
is used to remove such a specification from the
file.

10. B. The desktop is the primary GUI for Windows
9x. Within the desktop, the My Computer icon is
the primary navigation tool for the system, and
Windows Explorer serves as the primary file-
management tool. The Start menu is the sec-
ondary user interface for navigation.

11. A. The Add/Remove Hardware Wizard is used to
install and configure hardware devices.

12. D. The file-management system in Windows 9x
can accommodate filenames up to 255 characters
in length. This allows for very descriptive file-
names to be used to represent the contents of a
file.

13. C. The Windows 95 startup procedure produces a
backup copy of SYSTEM.DAT and USER.DAT each
time the system successfully boots up. Before
storing these copies, the system renames the old
SYSTEM and USER files with the .DA0 extension and
saves them.

14. D. ScanDisk is scheduled to run only when
Windows 2000 does not shut down correctly. It
runs in DOS mode before Windows boots up.

15. B. The utility for directly modifying the Windows
9x Registry is RegEdit. You can start this utility
from the command line by executing the REGED-
IT.EXE file.

16. A. An emergency startup disk for Windows 9x
can be created in the setup process during installa-
tion. Alternatively, it can be created at any time
via the Add/Remove Programs utility.

17. B. These are the steps for entering Task Manager:
Press Ctrl+Alt+Del, click the Task Manager, click
Applications, and close the applications that are
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encryption and administrative enhancements over
its predecessors.

25. D. Upper memory is the area of RAM in the PC
memory map between 640KB and 1MB. It has
existed since the original PC design. High memo-
ry is the 64KB area just above the 1MB mark that
is created by the segmented offset addressing style
of the Intel microprocessor. The high memory
area comes into existence when the HIMEM.SYS dri-
ver is loaded in the CONFIG.SYS file.

26. D. The Windows 9x System Monitor is designed
to monitor the operation of key system resources
and graphically identify processing bottlenecks
that occur.

27. D. HIMEM.SYS has two functions. It is the memory
manager responsible for controlling any other
memory managers in the system. It also provides
access to the extended memory area and creates
the high memory area.

28. B. Memory between 0KB and 640KB was origi-
nally referred to as base memory in the original
PC. When additional memory became available in
the PC-AT, however, in the form of expanded and
then extended memory, this area of memory
began to be called conventional memory.

29. A. These are the requirements set by Microsoft
for installation of the Windows 2000 Professional
operating system: 133MHz processor with 64MB
RAM installed.

30. C. Even if the Typical option is selected for the
installation, the Windows 9x Setup utility enables
the user to specify a new directory where the
Windows 9x files are to be placed. This new
directory can be located on a different drive.

31. D. You install a network printer in Windows 9x by
accessing the Network Neighborhood through its
desktop icon, selecting the remote computer’s net-
work name, and then selecting the remote printer’s

name. From this point, you right-click the Install
option to install the printer in the local system.

32. C. There is no standard mode in the Windows 9x
world. Normal mode is just the normal Windows
9x startup. Safe mode is a special troubleshooting
mode that loads only the minimum number of
device drivers required to get the basic parts of
the system operational. MS-DOS mode is a com-
mand-prompt–only mode that simulates the DOS
environment.

33. A. The correct sequence is NTLDR, NTDETECT.COM,
BOOT.INI. BOOT.INI next passes control to
OSLOADER.EXE.

34. A. Safe mode is a special troubleshooting mode
that loads only the minimum number of device
drivers required to make the basic parts of the
system operational. This includes a reduced ver-
sion of the Windows GUI environment. If the sys-
tem does not function in this mode, a command-
prompt–only mode is available to remove even
these few drivers. Safe mode startup also provides
a step-by-step bootup mode that you can use to
single-step through the bootup process and identi-
fy steps that cause the system to crash.

35. C. The Windows 95 Setup routine must find a
copy of a FAT16 partition running on the intended
drive where it is supposed to install Windows 95.

36. C. When Windows 9x boots, the system initializa-
tion occurs and POST tests are performed. The
Bootstrap Loader finds the MBR and loads the
Windows version of the IO.SYS file. IO.SYS
checks the CONFIG.SYS file for system configura-
tion parameters. IO.SYS then loads the MSDOS.SYS
file and checks its information. IO.SYS then looks
for and executes the COMMAND.COM file, which in
turn looks for and executes the AUTOEXEC.BAT file
if it finds one. Be aware that in a pure Windows
9x installation, no CONFIG.SYS or AUTOEXEC.BAT
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46. C. IPX/SPX was designed for use with Novell
NetWare networks.

47. C. VxDs are designed for 32-bit virtual-mode
operations under Windows 9x.

48. B. By default, Windows 9x provides easy-to-use
peer-to-peer networking software. It can be set up
as a client or a workstation for Windows NT,
Windows 2000, Unix, or Novell NetWare net-
works, but this is not its default networking
scheme.

49. A. Windows 95b allows the use of the FAT32 file
system. FAT32 allows partitions of up to 2TB in
size.

50. C. DHCP enables the host server to automatically
assign IP addresses and subnet masks every time a
client computer begins a network session.

51. D. The least likely (but not foolproof) source of
virus infections is original manufacturer, shrink-
wrapped software. Most reputable software manu-
facturers test their software and systems for virus-
es before placing them in the marketplace. All the
other sources of software listed provide a much
higher possibility for viruses to have been
attached to the software.

52. C. In Windows 9x the installation files are stored
on the distribution disks, or disc, in a compressed
.CAB format. These files can be moved and
expanded into the system by using the Windows
EXTRACT.EXE command in MS-DOS mode.

53. C. If the Virtual Memory function is disabled in
Windows 9x, the system stops running at some
point, and you are unable to restart it.

54. B. Because Windows 9x employs preemptive
multitasking, it is possible to exit to the Windows
task list, remove the offending task, and continue
processing. You access the Windows 9x task list
by pressing the Ctrl+Alt+Del key combination.

file is present. The order of events in all the other
possible answers is incorrect.

37. C. The Computer Management Console combines
many of the tools, including System Information,
Performance Logs, Shared Folders, Local Users,
Disk Management and Defragmenter, Logical
Drives, and Services and Applications.

38. D. You can access the Step-by-Step Startup option
by pressing the F8 key while the Starting
Windows message is onscreen. This action brings
up the Start menu, from which you can select any
of the various Windows startup modes.

39. C. Pressing the F5 key while the system is start-
ing up boots the system directly into Safe mode.
The system also defaults to Safe mode if it detects
a configuration problem that the PnP function
cannot sort out.

40. D. The Control Panel’s Add New Hardware
Wizard must be used to manually install a device
driver in the Windows system.

41. D. The Add/Remove Programs Wizard cannot be
used to install a device driver. All the other meth-
ods can be used to install a device driver.

42. A. The Event Viewer administrative tool is used
to view and manage the logs of system, program,
and security events that occur in the computer.

43. B. You encrypt files to protect them from access
by other users. You can encrypt files by using dif-
ferent cipher strengths. The files can be decrypted
after they are sent to the user.

44. B. The boot sector does not contain information
about the size and layout of the disk. That is the
function of the partition table.

45. C. Pressing the F8 key during startup causes
Windows 2000 to display the Bootup Options
menu, which includes options such as Safe mode.
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55. C. The PING command is one of the key tools for
troubleshooting TCP/IP. PING causes a data packet
to be sent to a specified IP address and returned to
your machine.

56. C. The thorough ScanDisk option checks the sys-
tem’s files and folders only for cross-linked files
to repair, and it also examines the disk surface for
physical defects.

57. D. All the answers provided for this question can
be used to share a printer with the system.

58. B. If a printer is not producing anything in a
Windows 9x/NT/2000/XP environment, even
though print jobs have been sent to it, you should
check the print spooler to see whether any particu-
lar type of error has occurred. To view documents
waiting to be printed, double-click the desired
printer’s icon. Return to the Printer folder, right-
click the printer’s icon, click Properties, and then
select Details. From this point, select Spool
Settings and select the Print Directly to the Printer
option. If the print job goes through, there is a
spooler problem. If it does not, the hardware and
printer driver are suspect.

59. C. There is no virus-checking function in the
Device Manager. In Windows 9x, there is no inte-
grated virus detection or correction; this feature
must be added from a third-party supplier.

60. A. An X associated with a device listed in the
Device Manager indicates that the device has
been disabled by a user-selection conflict.

61. B. The Device Manager lists all the hardware
installed in the system, along with the resources
that the hardware has been allotted. By selecting
the device from the list and clicking its driver,
you can enter the device’s Resources tab and
change its IRQ settings.

62. B. The correct UNC path begins with two slashes
and has both the computer name and the share
name for the device.

63. C. In Windows 2000, the appearance of file
extensions is controlled through the View tab in
Folder Options.

64. B. ISPs provide Internet addresses for their users.
ISPs purchase blocks of IP addresses that they
rent to their customers so that they can have
access to the Internet and identities on the Web.

65. C. If a working modem is already installed in the
system, only two things need to occur: Windows
needs to have its dial-up networking feature oper-
ational, and it needs to be loaded with the ISP’s
contact and configuration information.

66. A. All TCP/IP utilities are controlled by com-
mands entered at the MS-DOS command prompt
(for instance, C:>).

67. A. The File and Print Sharing option on the local
computer must be enabled for other network loca-
tions to see these resources on your system. If the
options were not enabled, others would not be
able to see or access your resources.

68. C. There is no X.40 file format. HTML is the for-
mat used to create Internet documents and pages.
FTP is used to transfer files across the Internet,
and POP3 is an email protocol format.

69. C. The Reconnect at Logon box is often over-
looked when someone is mapping a drive. When
the user logs off, the drive map disappears and
must be reentered at the next logon.

70. C. The command TRACERT hostname, where 
hostname is the IP address or DNS name of a host,
traces the path of a network connection to that
remote host.
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76. C. Microsoft typically releases its patches in the
form of updates or in collections that include
additional functionality or new device drivers.
Microsoft refers to these collections as service
packs.

77. D. The maximum hard-drive space is 2GB with
650MB of free space required; 2GB of free hard-
disk space is recommended. A 1.5GB partition
size is required, with 2GB recommended.
Additional disk space is required for installing
over a network. The maximum hard-disk space
supported for a partition is 2TB.

78. B. The Recovery Console available in Windows
2000 and Windows XP is a command-line inter-
face that provides access to the hard disks and
many command-line utilities when the operating
system will not boot (that is, after you’ve tried the
Last Known Good Configuration and Safe Mode
options).

79. C. One of the primary uses of the Recovery
Console is to restore the Registry. Every time you
back up the System State data with the Windows
2000 or Windows XP Backup utilities, a copy of
the Registry is placed in the \Repair\RegBack
folder.

80. B. The Windows XP System Restore utility
enables administrators to roll back the Windows
XP Professional operating system to a previous
operational state and configuration without affect-
ing any user’s personal data.

71. B. Windows XP/NT startup processes are similar
to MS-DOS/9x systems. The main differences are
found in the terminology and filenames that
Windows XP/NT versions employ. In the case of
a Windows XP/NT partition, the bootstrap loader
is the XP/NT loader file named NTLDR. This file is
the Windows XP/NT equivalent of the DOS
IO.SYS file and is responsible for loading the
XP/NT operating system into memory.

72. D. Configuration information about every user
who has logged in to the system is maintained in
a named subfolder under the \Winnt\Profiles
directory. The actual user configuration file is
named NTUSER.DAT (for example,
\Winnt\Profiles\Charles\Ntuser.dat). In
Windows 2000 and XP, the NTUSER.DAT file is
stored in \Documents_and_Settings\username.

73. A. Configuration information about every user
who has logged in to the system is maintained in
a named subfolder under the \Winnt\Profiles
directory. The actual user configuration file is
named NTUSER.DAT (for example,
\Winnt\Profiles\Charles\Ntuser.dat). In
Windows 2000 and XP, the NTUSER.DAT file is
stored in \Documents_and_Settings\username.

74. D. The Symmetrical Multiprocessing (SMP) func-
tion enables threads of any process to be applied
to any available processor in the system. The
SMP function also enables microprocessors within
a system to share memory space with and assign
threads to the next available microprocessor. 

75. C. In an unattended installation using answer
files, administrators run scripted answer files that
have been created to provide automatic answers to
all the questions normally asked by the
Setup/Install routine.
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